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Introduction

A walk through the cloud data management solution, teaching you
how to automatically upload and update your data from the familiar

workspace on your desktop.

You will explore the Fusion workspace and learn how to manage your
data.



Learning Objectives

Effortlessly upload files to the Autodesk cloud

Manage, share, markup, and visualize your data in the cloud

Access and edit your
Use Fusion Mechanica

oud data direction from your desktop

. with the cloud data management solution






Information You Will Need to Get Started

Format of the Class

1. We will walk you through small collections of steps in the
slides

2. Then you will do it yourself. |

Need help? Raise your hand.
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Information You Will Need to Get Started

A Fusion Hub has been created for the Lab

= Hub Name: ADSK Fusion
= URL: https://gmaill12570.autodesk360.com

= Username: Refer to your card
= Password: Fusion0O1




Data Management 1n
the Autodesk Clouad

Setup Your Project



Log into Fusion

Si

Don't have an Autodesk account?

1 Log into Fusion

autodeskfusion+01@gmail.com

Have a compar
Use your entery




Explore the Fusion Workspace

Administration | Settings

# | Team ADSK Fusion AF

eeeeeeeeeeeeeeeeeeeeeee

1 Log into Fusion

dle Drawing
W0 Craig Godfrey
. ° °
| A Chivit y

: QFQEQ & 2 Explore the Fusion
Project Space Details workspace
- Pane




Switch Between Hubs

" Adsk Fusion+01
autodeskfusion+01@gmail.com
4 My Account | Settings

Signed into

PINNED | ALL | OWNED B AdSk FUSi0n+01

Name ~

Team ADSK Fusion
fusionau.autodesk360.com

1 : :
YRV Log 1nto Fusion

Adsk Fusion+01 'Default
Managing Youl : myhub.autodesk360.com
Signed into

[ Sign Out
* Team ADSK Fusion ( ' - g 2 Explore the Fusion
Team ADSK FUSiOf\ Blade Guard Base.SLDPRT W O r kS p a Ce
«%. Adsk Fusion+01 Default u EEEEEE;OMWgWOW 3 SW]tCh h u bS

A A B e oA p——
My Account | Settings
Autodesk Fusic ' ~count >etlings

Sign Out



View Project: Managing Your Cloud Data

t Team ADSK Fusion

ALL | OWNED BY ME SHARED WITH ME

Name ~
" Managing Your CIoud‘ '
> .

Created By

Craig Godfrey

Created On

Aug 23, 2017

Create Project

Activity
joined Managing Your Cloud Data
Spindle Drawing
COWMET Craig Godfrey uploaded
—_— f to Managing Your Cloud
{ L r Data
== Sep 1,2017
Spindle Assembly Drawing
——— Craig Godfrey uploaded
¢ ES By
i 4 to Managing Your Cloud
| w i } Data
L Tl EEl Sep1,2017
12000-CMS Drawing
== Bl Craig Godfrey updated t0
R U Managing Your Cloud Data

| e, w | SeP1.2017

W ==
S R

PRD_Router Rev k

Craig Godfrey updated o

| Managing Your Cloud Data
~ Aug 31,2017

AF

1 Log into Fusion

2 Explore the Fusion
workspace

3 Switch hubs

4 Take a look inside
of a project




View Project: Managing Your Cloud Data

. . un 1 . .
" BB DISCUSSIO I—Og ]nto FUS]On
Q " [ WIKI PAGES

- e Explore the Fusion
s workspace

S 3 Switch hubs
[+]
o

4 Take a look inside

of a project




View Project: Calendars

Managing Your Cloud Data

SUNDAY MONDAY TUESDAY WEDNESDAY THURSDAY FRIDAY

Project AU2345 S.

f _ _ 1 Log into Fusion
el |

2 Explore the Fusion

=T workspace

3 Switch hubs

% Take a look inside

of a project



View Project: Discussions

Managing Your Cloud Data

A > Managing Your ..ata > Discussions

@ Start a new discussion

B3 DISCUSSIONS v

% Craig Godfrey

Welcome to Managing Your Cloud Data!

Take a minute and let us know what you think about the class in real time!

Discussions are a great way for team members to collaborate while working on a project
"Can we move the produ ... More

° 3 Adam Luttenbacher

Possibly the best class I've seen so far!

L] Reply

Details Activity
& Managing Your Cloud Data O
Project Type: Open
A ;

1 Log into Fusion

PROJECT MEMBERS (58)

Craig Godfrey Project Admin
craig.godfrey@autodesk....

Adam Luttenbacher Editor
adam.luttenba...r@autodesk.com

2 Explore the Fusion
35;';:::;3:;9«19@gnu:/.com Editor W O r kS p a C e

ADSK Fusion+11

autodeskfusion+11@gmail.com Editor
itch h
Adsk Fusion+01 : S W.I t C u b S
. i Editor
autodeskfusion+01@gmail.com
ADSK Fusion+41 :
Editor

autodeskfusion+41@gmail.com

ADSK Fusion+45

aulﬁdesk!us:on*45@Emar/.com Editor 4 Ta ke a lO O k ] N S] d e
of a project

P OO0OOO @&




View Project: Wiki Pages

® ® [ Managing Your Cloud Data - - x ' §\ Help: About Wiki Pages % I\ Overview | Autodesk Univers: x ~ [- Desktop Connector Solution - Craig
& C (0 @ Secure https:/fusionau.autodesk360.com/g/projects/2017082389375476/pages/PGabee1QT1a327¢f2b7a5f93d80b6dda64b3?show=comments w §$H O Q :
i Apps @ Infosys W FLC Jira ADSK [ Personal [ Hogwarts [ Things to look at £ Fusion Lifecycle £71 Fusion [ Autodesk F1DSGN F\cC |l Stock ¢ Blue Team Dashboa... » [ Other Bookmarks

G Managing Your Cloud Data COMMENTS

P\dd a new comment

MFG125066-L: Managing Your Cloud Data

. Post Cancel
Learning Objectives

o Effortlessly upload files to the Autodesk Cloud
* Manage, share, markup, and visualize your data in the Cloud

* Access and edit your Cloud data direction from your desktop ‘ Craig Godfrey 1 LO g 'i n t O F u S 'i O n

* Use Fusion Mechanical with the cloud date management solution.

Has anyone reviewed this yet?

Description

In this hands-on lab, we will walk you through our cloud data management solution, teach you how to automatically upload and
update your data from the familiar workspace on your desktop, and allow you to explore the wide range of functionality provided
to you by the Autodesk cloud services. Come to this course to grab the wheel and take a spin through our cloud data
management experience.

Your AU Expert(s)

Adam Luttenbacher

Adam Luttenbacher is a product owner for Autodesk, Inc.’'s desktop and cloud data management solutions. With over 14 years of experience,
Adam has played a significant role in improving both the user's experience and the product quality of Autodesk’s data management
applications. Educating and interacting directly with the user community at Autodesk University each year has been a top priority for Adam

2 Explore the Fusion
workspace

Craig Godfrey

Craig Godfrey is an employee of Autodesk working in various areas of the Fusion platform in the Novi Michigan office. Craig has worked at
Autodesk for 14 years, with various roles such as quality assurance, experience design, and now product owner. With a primary focus on Data
Management (Vault & Fusion Lifecycle) his goal is to provide quality functionality and improve the user experience along the way.

3 Switch hubs

4 Take a look inside

of a project




YOUT Turn L Log into Fusior

z Explore the Fusion
workspace

2 el s

4 Take a look inside
of a project



Create Your Own Project




Project Types

Settings

Project Type

This setting determines who can view your project and access its data.

) open 1 Create a New

Any Team Member can ask to join this project (Please note, Projector Contributor access is restricted) P .

© Closed
Only invited members can access this project.

| Secret
Only invited members can see this project.

() Allow Project Contributors (There are 0 Project Contributors.)

Cancel ‘ Save




Create a New Project

Team ADSK Fusion

ALL OWNED BY ME SHARED WITH ME Create Project

Activity

joined Managing Your Cloud Data

Name v Created By Created On

Managing Your Cloud Data Craig Godfrey Aug 23, 2017

Spindle Drawing

ey Craig Godfrey uploaced 1 C r e a te a N e W

to Managing Your Cloud

Project

:

=

|

Spindle Assembly Drawing

Craig Godfrey uploaced
to Managing Your Cloud
Data

Sep 1,2017

i | Craig Godfrey updated 0
S U Managing Your Cloud Data
| Sep 1,2017

O ]

PRD_Router Rev k

Craig Godfrey updated 0
Managing Your Cloud Data

Aug 31, 2017




Create a New Project

Create Your New Project

Project Name(required) You have 49 characters left

1 Create a New
Project

Don Johnson

Choose a Project Avatar(required)

Upload
Your Own

Zz
A2




Change Project Type

Home

)SK Fusion

Team AD
Autodesk Fusion 01

> Autodesk Fusion 01

You haven't uploaded any data yet.

Drag and drop Upload

B DATA v
Details Activity
l . Autodesk Fusion 01 O
% Project Type: Closed
‘ Follow Pinned

PROJECT MEMBERS (1)

Adsk Fusion+01 ) )
autodeskfusion+01@gma... Project Acmin

View and Manage Members

Gear Icon

1 Create a New

Project




Change Project Type

Settings

Project Type

This setting determines who can view your project and access its data.

Open 1
Any Team Member can ask to join this project (Please note, Projector Contributor access is restricted) C red te d N ew

Project
Closed
Only invited members can access this project.

Secret
Only invited members can see this project.

() Allow Project Contributors (There are 0 Project Contributors.)




Add People to Your Project

PROJECT ACCESS LEVELS

Project

Viewer .
Admin

View
Files(online), folders, comments(view and v v
post) and people

Discussions & Calendar
Access to conversations and events

1 Create a New
Project

Get Link and Live Review
Get link for shared files and initiate live
review

2 Add people

Edit, Upload, Download
Copy, move, rename and delete files/folder

Manage Sharing

Enable and set public sharing, invite others to
project

Project Admin

Project settings, approve people in project,
set access levels




Manage Project Members

Details Activity

| AU Dry Run
q 4 SubFolders

Project Type: Open

Qs+ Jolned Project A rollow

v Pin

1 Create a New

PROJECT MEMBERS (2) Project

Adsk Fusion
autodeskfusion@gmail.com

Adsk Fusion+01 _ _
autodeskfusion+01@gma... ' rojectAdmin

2 Add people

View Members Details !



Manage Project Members

Who do you want to invite to this project?

Email addresses or names of the people you'd like to invite(required) ROLE @ 1
Create a New
autodeskfusion@gmail.com ¥ Editor v :
| 4 Project
Editor

(Don't use mailing lists.)

it 2 Add people

Project Contributors are allowed in this Project.
Users you invite will be invited as Project Contributors into this hub.

Cancel \ Send Invitations




Create a Folder Structure

2 Upload + New HH Details Activity

i Folder &7
Name 4 Owner = Type Si ated

@ Fusion Design - . Autodesk Fusion 01 <
i Office Files Folder Adsk Fusion+01 ~ Folder ~ jusuiceently % Project Type: Closed C N
i Lab Fusion Design Data Adsk Fusiont01 ~ Folder ~ Justrecently r e a t e a e W

.‘ Follow + Pinned
| . t
PROJECT MEMBERS (2) ]
Y A

Ml Folder (& 3 Create a folder

U Fusion Desig

structure 1n your
project




Your lurn feEEs

2 Add people

3 Create a folder
structure in your
project



A Connected Desktop

Access Your Cloud Data from Your Workspace



Log in from Tray

Sign In... (&B

Work Offline

Pending Actions 1
Log in from tray

Exit




Log in from Tray

A Sign in

Sign in A

Emall

<username=

1 :
OGO EEy

NEW TO AUTODESK? CREATE ACCOUNT

Username
autodeskfusion+01
Password

Fusion01




View Hubs and Folders

O

Fusion 360 Data Set

<« v P > ThisPC » Fusion360 > ADSK Fusion » Managing Your Cloud Data » Fusion 360 Data Set v O Search Fusion 360 Data Set e

Organize v =« [ @

[ This PC

A A
ar A360 Drive
B BIM 360 Team

B Desktop

- ASSY - Gantry ASSY - Rotary ASSY - Router Ball CPM-3441-LS.Fus
Documents RevK.FusionDesig Tool Table - Screw.FusionDesi ionDesign
; Downloads n Changer.FusionD Aluminium.Fusio gn
esign nDesign
[ Fusion 360
*¥: ADSK Fusion - /N
Managing Your Cloud Data Yy, : 2 - -
Ea—— & Y = View hubs, projects,

Recprocating Sow lnventor Danaher-Default.  EZF(EZF-2030-34)  MJB-65-BL-15-20 PRD_Router PRD_Router Rev

My New Project FusionDesign .FusionDesign .FusionDesign Image.png k.FusionDesign VIR >
) Gearhead.Fusion
D Music Design
== Pictures
B Videos

‘s Local Disk (C:)

and folders

1? Network

v Ser'ial Skeleto'n - Skeleton - Z.to X Spind'le Assernbly Spindle

~ - L) ~ ' L4 -~ A L) -~ - ~

38 items 1 item selected




Your lurn [snens

2 View hubs, projects,
and folders




Add Data to the Cloud

S

Simple Files Design Files SIS
(with relationships) Ry
B XY
@Qt ¥ Sivai :\\‘n i
Choose your own adventure
§\\\\ ﬂm\am\
%
%,“3{‘; 1\1!'11
S swplae



Add Data to the Cloud

Data set is on your machine here: C:\DATASETS\Adam Luttenbacher

[ 5 | Adam Luttenbacher

File Home Share View

« o v

[&] Pictures

B Videos

‘s Local Disk (C:)
77d166a24be0d0751d0687k
Autodesk
DATASETS

Adam Luttenbacher

ECS
Installs
Inventor 2017
PerfLogs
Program Files
Program Files (x86)
SOLIDWORKS Data
temp
TESTDATA
Users
Windows

XML

=& Neohanrl
4 items

3 items selected 4.80 MB

A

v

<

<« DATASETS » Adam Luttenbacher

Name

Inventor Saw
[#] Lab PowerPoint.pptx
Lab Text File.txt
D Lab Word Document.docx

Search Adam Luttenbacher P

Date modified

11/10/2017 1:21 PM
11/10/2017 1:24 PM
11/10/2017 1:21 PM
11/10/2017 1:21 PM

Type

File folder
PPTX File

Text Document
Office Open X

AU Fusion+01
<« v 1
Organize v

5+ Quick access
@& OneDrive

= This PC
a2 A360 Drive
B BIM 360 Team
[l Desktop
Documents
4 Downloads
[F Fusion 360
+¥: ADSK Fusion
AU Fusion+01

Marketing
Sales
Technical Documents
Managing Your Cloud Data
ﬁ Music
[&=] Pictures

B Videnc
4 items

<« ADSK Fusion > AU Fusion+01

Name

Designs
Marketing
Sales

Technical Documents

Search AU Fusion+01

B«

Created By




Add Data to the Cloud

For design data, choose the Reciprocating Saw Assembly Top Level.iam

| M = | Inventor Saw
Home Share View
< v <« Adam Luttenbacher > Inventor Saw v O
=] Pictures A Name
B Videos % Battery Plug.iam
‘wa Local Disk (C:) % Blade guard Assembly.iam
77d166a24be0d0751d0687k % Blade Holder Assembly.iam
Autodesk % Connecting Rod.iam
DATASETS Eﬂ Motor Internals.iam
Motor.i
Adam Luttenbacher % i indand
Ecs % Reciprocating Saw Assembly Top Level.iam
% Reciprocating Saw Harness Assembly.iam
Installs % Short Rod Assembly.iam
Inventor 2017 5 Snap Hook Assembly.iam
PerfLogs % Trigger Assembly.iam
Program Files @ Ball Bearing.ipt
Program Files (x86) @ Battery Connector.ipt
PI i
SOLIDWORKS Data £ Battery Plug (Bottom) it
@ Battery Plug (Top).ipt
temp () Battery Plug Clip.ipt
TESTDATA @ Battery Plug Shaft.ipt
Users @ Battery Plug Spring.ipt
Windows 1) Big Gear Shaft.ipt
XML 1) Blade Guard Base Pin.ipt
A v~ n A .-
=& Nehunrl Y
68 items  1item selected 2.37 MB

O X

Search Inventor Saw

Date modified

11/
1/
11/
11/
11/
1/
1/
11/
1147
11/1
1171
117188
11/1
/10/2017 1:21 PM
/10/2017 1:21 PM
/10/2017 1:21 PM
/10/2017 1:21 PM
/10/2017 1:21 PM
/10/2017 1:21 PM

—_

10/2017 1:21 PM
10/2017 1:21 PM
10/2017 1:21 PM
10/2017 1:21 PM
10/2017 1:21 PM
10/2017 1:21 PM
10/2017 1:21 PM
10/2017 1:21 PM

| PM

0/2017

-y

:21PM

(4N A4AT 4 M4 P

>

Type

Autodesk Iny
Autodesk Iny
Autodesk Im
Autodesk Im
Autodesk Im
Autodesk Iny
Autodesk Im
Autodesk Im

Autodesk Im

Autodesk In

| Autodesk Im

P Autodesk Imy

| Autodesk Im
Autodesk Imy
Autodesk Im
Autodesk Im
Autodesk Im
Autodesk Im
Autodesk Iny

Autodesk Im
v

>

AU Fusion+01
« . P
Organize v

5+ Quick access
@& OneDrive

= This PC
a0 A360 Drive
B BIM 360 Team
[l Desktop
[‘_:_] Documents
; Downloads
[F Fusion 360
¥ ADSK Fusion
AU Fusion+01
Designs
Marketing
Sales
Technical Documents
Managing Your Cloud Data
J) Music
[&=| Pictures
B Videnc
4 items

<« ADSK Fusion > AU Fusion+01

Name

Designs
Marketing
Sales

Technical Documents

Search AU Fusion+01

Created By

hd

ye)

[ 1 Add data to the

cloud




Don’t Forget Your IPJ!

= If you choose to add CAD data, Inventor files require an ipj
(project) file.
= WWe have included one in the data set for you to choose.

1 Add data to the
I\ Select an Inventor Project File X cloud

Moving Inventor files into the Autodesk Desktop Connector
workspace requires the selection of an Inventor project file. Select a
project file relevant to this data.

Selected project file: @ Trigger.ipt

Reciprocating Saw.ipj
_‘1‘1 | Lfila |~

Cancel




Quick Demo



Your lurn fee=es




Fusion Data
Management

Explore the Functionality



To the Cloud!

1. Go to the “Managing Your Data” project.

WA W W/ Gl 1\

reciprocating saw

2. Find the “Reciprocating Saw Assembly Top Level.iam”

n Reciprocating Saw Inventor

@ v

Organize ~

= This PC

b Music

66 items

33 Dropbox

N « Fusion 360 » ADSK Fusion » Managing Your Cloud Data > Reciprocating Saw Inventor

& OneDrive

B BIM 360 Team
m Desktop
Documents
& Downloads

[F Fusion 360

= Pictures
B Videos
% 9 Windows (C)

¥ Network

*§ Homegroup

v

1 item selected

~ [:| Name

() Reciprocating Rod.ipt
V&3 Reciprocating Saw Assembly Top Level.iam
2, Reciprocating Saw Harness Assembly.iam
Eﬁ Reciprocating Saw Harness.ipt
7 Rod Clip.ipt
Eﬁ Rotor Arm.ipt
@ Short Rod Assembly.iam
7 Short Rod.ipt
7 Small Bushing.ipt
7 Small Spur Gear.ipt
2 Snap Hook Assembly.iam
Y, Snap Hook Base.ipt
(7 Snap Hook Slider.ipt
Y, Snap Hook Spring.ipt
Y, Snap Hook.ipt
@ Trigger Assembly.iam
Y, Trigger Box Collar.ipt

Created By
Craig.Godfrey

Open...
Go To
Copy Link

Export...

#  Delete

Rename

7 b4

Craig.Godfrey
Craig.Godfrey
Craig.Godfrey
Craig.Godfrey
Craig.Godfrey
Craig.Godfrey
Craig.Godfrey
Craig.Godfrey

O X

v O  Search Reciprocat.. P

File Size
160 KB
2.37 MB
61.0 KB
130 KB
114 KB
133 KB
75.5 KB
98.5 KB
82.5KB
187 KB
122 KB
195 KB
102 KB
253 KB
292 KB
90.5 KB
131 KB

f==
== =
==

m @

1 Go to the cloud data




To the Cloud!

Reciprocating Saw Assembly Top Level.iam v~

COMMENTS

nventor assembly files | 24 MB I Shared Link

e ast Updated on 8 hours ago
3y Craig Godfrey

Start a conversation.

P — 1 Go to the cloud data

Design References

USES (24) USED IN DRAWINGS

Motor.iam V.1 ISB1111-AM4x8... V.1 Gear Housing Cover... V.1 ISB1111-AM3.5x.. V1 Blade Holder Assem... V.1




Overview and Related Data

Reciprocating Saw Assembly Top Level.iam v -

ﬂ Inventor assembly files | 24MB | Shared Link COMMENTS

e Last Updated on 5:51 AM November 7, 2017 Start a conversation.

By Craig Godfrey View and comment
1 Go to the cloud data

Design References

USES (24) USED IN DRAWINGS

jn_»;w";') e

) 'n,w;w

-l
-l

L]
Motor.iam V.1 JISB1111-AM4... V. Gear Housing Cov... V.1 JISB1111-AM3.... V.1 Blade Holder Ass... V. JISB1111-AM3.... V. Blade.ipt Large Spur Gear.ipt V.1 Ove r'V'I e W p a g e

Big Gear Shaft.ipt LAl Gear Housing Cov... V. Battery Plug.iam V. Reciprocating Sa... Short Rod Assem... V. Snap Hook Assem... V. Blade guard Asse... W Guide Block.ipt

R - R

: N

J J




Your Turn (s

e Explore the
overview page




Model Viewer in Fusion




Large Model Viewer

1 Navigate to Viewer

Reciprocating Saw Assembly Top Level.iam v1 -

Inventor assembly files I 24MB | Shared Link COMMENTS

s Last Upndated on 5:51 AM November 7, 2017 Start @ conversation
By Craig Godfrey




Large Model View: View File Structure

1 Navigate to Viewer

2 View file structure

4 Reciprocating Saw Assembly Top Lavel
4 Reciprocating Saw Assembly Top Level
4 reciprocating saw assembly guts v1
.) Gear Housing
Guide Block
Motor
Motor Internals
Big Gear Shaft
Blade Holder Assembly
Short Rod (1)
Small Spur Gear
Large Spur Gear
Connecting Rod
Trigger
Blade guard Assembly
Blade Guard Base
Blade
Battery Connector

Guide Block

P Trigger v1




Large Model View: Isolate Components

1 Navigate to Viewer

2 View file structure

3 Isolate components




Large Model View: Create Markup

1 Navigate to Viewer

2 View file structure

g
3 Isolate components

4 Create Markup

!\




Large Model View: Add Comments

1 Navigate to Viewer

2 View file structure

3 Isolate components

4 Create Markup

!‘

S Add comments

A

(=




Large Model View: Explode Assembly

1 Navigate to Viewer

2_ View file structure

g

3 Isolate components

4 Create Markup

l‘r'\

S Add comments
="

6 Explode assembly

Ll




1 Navigate to Viewer

2 \liew file structure

Your Turn R T—

4 Create Markup

i,

> Add comments

Explode assembly

B R



Working with Your Data




Modify Desktop Files | Rename

R My Office Files RS 1 Edit local files
<« v 4 > This PC » Fusion 360 > ADSK Fusion > My New Project > My Office Files v O  Search My Office ... @
Organize ~ = W @
A - . .
© Creative Cloud Files [] Name Created By File Size
22 Dropbox @ Lab PowerPoint.pptx autodeskfusion90 1.95 MB
Lab Text File.txt autodeskfusion90 452 KB
& OneDrive Lab Word Document.docx autodes)fucianan 2.82 MB
Open...
= This PC
Go To
B BIM 360 Team Copy Link
m Desktop
. Export...
Documents
& Downloads X Delete
F Fusion 360 Rename
¥ ADSK Fusion
Managing Your Cloud Data
My New Project
Design Data
My Office Files
J Music
&= Pictures
B Videos v < >

3items 1 item selected 2| =




Modify Desktop Files | Move

Folder

2. Drag and Drop the filesinto t
result should look like the fol

Right Click in the white space and select New

ne new folder. The

owing

B My Office Files — ] X
— v > This PC » Fusion 360 » ADSK Fusion » My New Project » My Office Files v U  Search My Office ... @
Organize ~ E= - @ 0
= This PC A [] Name Created By File Size
B BIM 360 Team @° Lab PowerPoint.pptx autodeskfusion90 1.95 MB
m Desktop Lab Text File.txt autodeskfusion90 4.52 KB
Documents Name Changed.docx autodeskfusion90 2.82 MB
Office Documents
& Downloads
[ Fusion 360
¥ ADSK Fusion

1 Edit local files

2 Move files



Modify Desktop Files | Open and Edit

1 Edit local files

j] Untitled - Notepad — O

File Edit Format View Help

2 Move files

/] Open X
<« v <« AU Fusion... » Technical Documents v O Search Technical Documents  ©

Organize v New folder Bz v [N 0 3 Open and ed]t f]les

[F Fusion 360 A Name Created By R

¥ ADSK Fusion Lab Text File.txt autodeskfusion01 -
AU Fusion+01

Designs

Marketing

Sales

Technical Documents

Managing Your Cloud Data

J5 Music

&= Pictures

B Vidanc e = 2
File name: | Lab Text File.bdt v | | Text Documents (*.txt) v

Encoding: | ANSI v




Modify Desktop Files | View Edits

1. Right Click on the edited file and choose “Go to”.

2. Choose folder in bread crumb.
3. View edits in Fusion Team

Team ADSK Fusion

My New Project

£

A > MyNewProject » My Office Files

Moves an d Renames
match the changes made
on the Desktop
Name a Owner

pl Office Documen ts / Adsk Fusion+90

B Lab Text File.txt Adsk Fusion+90

Version has updated to
reflect the edits you made
in the native application
"

1 Edit local files

2 Move files

3 Open and edit files

4 View your edits




Modify Desktop Files | Promote File Version

1 Edit local files

2
: 3 Open and edit files

4 View your edits

S Promote file

versions




Modify Desktop Files | View Versions

1 Edit local files

Using the version switcher, change the versions to
view the differences between the versions.

2 Move files

Lab Text File.txt

3 Open and edit files

Versions

Updated by Adsk Fusion

3
4 View your edits

| EppseanE e v e m—— Updated by Adsk Fusion+01

1 Created by Adsk Fusion+01 5 P rO m Ote f] I.e
versions

l il
i
|
!
_{
_i

Close

6 View the version

differences




Your lurn

Edit local files

Move files

Open and edit files

View your edits

Promote file

versions

View the version
differences



More Fusion
Capabilities



Navigate to Fusion 360 Files

Team ADSK Fusion

Managing Your Cloud Data

A > Managing Your Cloud Data <

1 Share data with
others

Name a4

B Fusion 360 Data Set < Craig Godfrey

g8 Reciprocating Saw Inventor Craig Godfrey




Share Files With Others

M

N _
N
N _

P e Spindle Assembly

Y
K

Name a

Skeleton - Master

A > Managing Your ...ata

anaging Your Cloud Data

> Fusion 360 Data Set

Skeleton - Z to X Interface

Spindle

Spindle Assembly Drawing #'

Spindle Drawing

nnnnn

I

O Nnel

Craig Godfrey
Craig Godfrey
Craig Godfrey

Craig Godfrey

Craig Godfrey

Craig Godfrey

Craia (cnndfray
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Compare Versions

1. Go to the “Spindle Assembly”.
2. Choose the drop down.
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Compare Versions

1. Go to the “Spindle Assembly” in the “Fusion 360 Data Set” project.
2. Compare version 4 and version 3.
3. Choose "Compare”.
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Compare Versions

1. Go to the “Spindle Assembly” in the “Fusion 360 Data Set” project.

1) share files with
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2. Compare version 4 and version 3.
3. Choose "Compare”.

6453K144:4 (Body?2)

Changes between versions 3 & 4

This element has been removed in version 4




INFORMATION X

6453K144:4 (Body2)

CHANGES

Changes between versions 3 & 4

his element has been removed in version 4
0 5
Added Removed

Modification type

D) ||| <P

Flat Result List Result as Tree

6453K144:4 (Body1)

6453K144:4 (Body2)

6453K144:4 (Body4)




Almost
Playtime!



CP122622 - Using new Autodesk workflows for
Inventor and Fusion 360 Interoperability

Want more information on Fusion and
Inventor?

Date and Time: Thursday, 8:00 AM - 9:00 AM

Speakers: Loren Welch, Jamie Scherer, Bankim
Charegaonkar

Class format: Instructional Demo




Super pumped about this ¢lass?
Take the survey!




Do you feel like this class could have been better?
Have a drink..then take the survey!



Playtime!

= Create wiki, calendar, or discussions
= Explore the viewer and mark-it-up.
= Make edits on desktop

= Promote versions

= Compare versions

= Share files

= Editin Fusion 360 - Extra Credit!
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